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حق نشر

شما می توانید با رعایت نکات زیر آزادانه از مطالب این کتاب استفاده کنید:

ذکر منبع را فراموش نکنید..1

چنانچه مطلبی اضافه2 کردید آن را نیز آزادانه در اختیار قراردهید..2

پدید آورندگان
برای این نگارش�

حجت‌اله مداحی

برای نگارش‌های قبلی

شرکت دانش‌بنیان سامانه‌های آزاد فناوری اطلاعات ایده‌آل آینده ایرانیان )سافا(

بازخورد
 بهدر خصوص این کتاب را به طور مستقیملطفا هرگونه پیشنهادها، انتقادها و بازخوردها و نکات خود 

  ارسال فرمایید.goodlinuxuser@chmail.irرایانامه 

تاریخ انتشار و نسخه نرم افزار
۷.۱ میلادی( ب22رای نس22خه ۲۰۲۱هجری شمس22ی و ۱۴۰۰)۱۴۴۲این راهنما همزمان با عید غدیر 

آغاز شد.

ممکن است در سایر نسخه مقداری تفاوت وجود داشته باشد.
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راهنمای شروع به کار با لیبره آفیس-رایتر

مقدمه

این کتاب برای چه افرادی4 است؟

لیبره آفیس یک مجموعه نرم افزار اداری پرکاربرد، آزاد، متن‌ب22از اس22ت ک22ه ش22امل چن22دین بر2نام22ه
ه22ای داده و فرم22ول نویس22یپایگاه‌قدرتمند برای واژه پردازی، صفحات گسترده، ارائه‌ها، گرافیک‌ها ، 

است.

رای22تر ی22ک ن22رم اف22زار واژه پ22رداز اس22ت ک22ه ب22ا ق22الب ه22ای متن22وع از جمل22ه مایکروس22افت ورد)
doc,  .docx سازگار است و شما می‌توا2نید کار خ22ود را در چن22دین ق22الب ازجمل22ه ) .pdfخ22روجی 

بگیرید.

 خواه22دیافت.ارزشمند2هر فردی که می خواهد به2 سرع2ت بالا در  در کار با  رایتر برسد این کتاب را  
شما ممکن است در استفاده از نرم‌افزار واژه پرداز تازه کار باشید یا ممکن اس22ت ب22ا دیگ22ر مجموع22ه

نرم‌افزارهای اداری آشنا باشید.

چه چیزی4 در این کت4اب است؟

 را۷.۱این کتاب ویژگی‌ها و امکانات اصلی رای22تر یع22نی2 بخش واژه پ22رداز از مجموع22ه لی22بره آفیس 
معرفی می کند2 و دستورالعمل استفاده از آن را فراهم می‌سازد.

یادداشت

نسخه های برخط و دیگ22ر نس22خه2 ه22ا نوشته شده است؛ ۷.۱این کتاب برای نسخه 
ممکن است از آنچه در این کتاب2 توضیح داده شده است  در ظ22اهر و عملک22رد کمی

متفاوت باشد.
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لیبره آفی4س را از کجا بگیرم؟

برای2 لین22وکس، وین22دوز و مکینت22اش ب22ه ط22ور رایگ22ان و آزاد در لیبره آفیس نسخه2 های مختلفی از  
در دسترس است. کاربران https://www.libreoffice.org/downloadدسترس است و از نشانی  

لینوکس همچنین نسخه متناسب با توزیع های مخلف لینوکس را خواهندیافت.2 در ص22فحه ب22ارگیری
نسخه2 قابل حمل)بدون نیاز به نصب( و نسخه های دیگر فهرست شده است. 
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راهنمای شروع به کار با لیبره آفیس-رایتر4

۱فصل 
آشنایی با محیط برنامه



معرفی-رایتر چیست؟

 واژه پرداز مجموعه آزاد و پر امکانات لیبره آفیس آزاد است. به عب22ارتی ب22رای  امکان22اتبخشرایتر 
معمول یک واژه پرداز)درج متن2، ویرایش و قالب بندی،صفحه آرایی، بررس22ی کنن22ده دس22تور زب22ان،

فرهنگ جامع و تصحیح خودکار؛ جستجو و جایگزینی؛ و…( رایتر امکانات فوق‌العاده‌ای دارد.

(word processor)واژه پرداز 

رم‌افزاری است که2 از آن برای ایجاد، ویرایش، صفحه آرایی و تولید ص22فحات مت22نین
استفاده می‌شود که البته ممکن است شامل تصاویر و اشکال گرافیکی نیز باشد.

صفحه آرایی

به آرایش متن، نحوه چیدن تصاویر، حاشیه بندی صفحات و تنظیمات چاپ، صفحه
آرایی گفته می‌شود.

اجزای پنجره اصلی رایتر

 نشان داده شده است که در این بخش در مورد آن توضیح داده۱ شکل شماره پنجره اصلی2 رایتر در 
شد2ه است.

یادداشت

به طور پیش فرض، دستورات رایتر لیبره آفیس همان طور که در این بخش توض22یح
رایتر ب22رای دسترس2ی ب22ه2داده شده است در منوها و نوارابزارها گروه بندی شده اند. 

ابزارها و دستورات، هفت رابط ک22اربری  متن22وع از جمل22ه روب22ان2 ک22ه مش22ابه آن در
viewمایکروسافت ورد وجود دارد را از طری22ق من22وی  ...  →  User  Interface

فراهم آورده است.
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 نوار عنوان
Titleنام لاتین آن   Barاست و در بالاترین قسمت پنجره قراردارد ک22ه ن22ام پرون22ده ج22اری در آن 

 را ذخ22یره نک22ردهآن ت22اکنونمشاهد2ه می شود.در2 صورتی که2 پرونده جاری نامی نداشته باشد یع22نی 
)بی عنوان( را مشاهده خواهید کرد.untitledباشید 

نوار منو
Menuنام لاتین آن   Barاست و جای آن در لینوکس و ویندوز زیر نوارعنوان اس22ت و در سیس22تم  

عامل مک بالای صفح2ه نمایش است. موقعی که شما یکی از منوها را انتخاب می‌کنید یک زیرمنو باز
می شود که گزینه های2 بعدی را نمایش می دهد از جمله:

( درSave( ی22ا ذخ22یره)Closeفرامینی  که بلافاصله عملی را انجام می دهند مانند2 بستن)•
(Fileمنوی پرونده)

فرامینی که پنجره‌های محاوره ای را باز می‌کنند که ب22ا س22ه نقط22ه د2ر ادام22ه فرم22ان قاب22ل•
تشخیص هستند، مانند

2... Find and Replace(در منوی ویرایش Edit)

فرامینی که زیرمنوهای بعدی را باز می کند. آن‌ها با پیکان کوچکی  مشخص هستند که در•
(. ب22اView در من22وی نم22ا)Zoom( و Toolbarsادامه فرمان آمده است، مانند نوارابزارها)

 مکان نما روی آن ها، زیرمنو باز می‌شود.2بردن 
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جانبینوار 
 نشان داده شده است  به طور معمول  ] ب22ه۱ است و همان طور شکل شماره Sidebar نام لاتین آن

طور پیش فرض در زبان های راست به چپ مانند فارسی، سمت چپ و در لاتین سمت راس22ت[  در
کنار پنجره رایتر باز است.

  در نوار ابزار می توانید آن را ظاهر یا مخفی کنید.همچنینSidebar←در صورت لزوم از منوی نما  
 دیده می ش22ود، دکم22ه ای در کن22ار خ22ود  ب22رای نم22ایش۲نوار کناری همان طور که در شکل شماره

دادن/مخفی کردن دارد.
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: قسمت‌های پنجره اصلی رایتر۱شکل 

(، ص22فحه)Properties دسته2 است: خصوص22یات)۶نوارکناری رایتر به طور پیش2 فرض مشتمل برا 
Page(س22بک‌ها ،)Styles(نگارخان22ه ،)Galleryبر)(، ن22اوNavigator2(و ب22ازرس س22بک ،)Style

Inspector  نوار  باز می شود. کناری( است.هر دسته با کلیک رو شمایل مربوطه 

یک تابلو ترکیبی از ن22وارابزار و پنج22ره‌ مح22اوره‌ایهر دسته2 شامل نوار عنوان و محتویات تابلوهاست.
است. نوارابزارها و تابلوهای نوارکناری کاربردهای زیادی به2 اشتراک می گذارن22د. ب22ه عن22وان مث22ال،

( می کند  هم در نوار ابزار قالب بندی در پنج22ره اص22لیitalic(یا مایل)Boldشمایلی که2 متن را توپر)
( در دسته خصوصیات.Character panelوجود دارد و هم در تابلو نویسه)

رای هماهنگ کردن ع22رض نوارکن22اری، نش22انگر موش22ی را دی22واره بین فض22ای ک22اری و نوارکن22اریب
قراردهیدو هرگاه شکل نشانگر به پیکان دو طرفه تغییر کرد، کلیک کنید و به2 راست یا چپ بکش22ید.
اما این کار کارایی چندانی ندارد چراکه برخی از دسته های با توجه2 ب22ه محتوی22ات آن از ح22د معی22نی

کم‌عرض تر نمی شوند.
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ی2ا ب2ه شناور کنی2د2 از گوشه2 پنجره اصلی جدا کنید و به عبارت دیگر آن رابرای2 این که نوار کناری را 
گوشه دیگر پنجره وصل کنید از فهرست کشویی تنظیمات نوار کناری واقع در ب22الای ن22وار اس22تفاده

 را ببینید(۳کنید2.) شکل شماره

ز همیناباش22د هم می توانی22د فع22ال برای2 انتخاب این که می خواهید چه زبانه ه22ایی در نوارکن22اری 
فهرست  استفاده کنید.

جانبیدسته‌های نوار 
 در نوار کناری در زیر شرح داده شده است.شامل شدهدسته‌های 

 حاوی ابزاره2ایی برای قالب‌بندی مستقیم محتواست.(:Propertiesدسته خصوصیات)�

زمانی که یک متن انتخاب شده باشد2 این تابلوها ظاهر می شوند::

(: اعمال، ایجاد یا به روزرسانی سبک یک بند.Stylesسبک‌ها)–

(:اصلاح خصوصیات متن مانند نام قلم، اندازه، رنگ، وزن یا فاصله بین نویسه‌ها.Characterنویسه)–

(: اصلاح ترازبندی بند، رنگ پس زمینه، تورفتگی، فاصله و شماره یا علامتگذاریParagraphبند)–
فهرست‌ها.

 یا گرافیک انتخاب شده باشد2 این تابلوها ظاهر می شوند:تصویرزمانی که یک 

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–
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: منوی تنظیمات نوار کناری۳شکل 

حالت رنگ، و شفافیت.( رنگ، contrast : اصلاح روشنایی، تضاد)(Imageصویر)ت–

 به متن دور آن.با توجه (: اصلاح موقعیت شکل یا تصویرWrap لفافه)–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

زمانی که شی رسم شده انتخاب شده باشد این تابلوها ظاهر می شوند:

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–

 هماهنگی درخشش یا لبه های نرم و شفافیت  پس زمینهیا(:افزودن Effectجلوه)–

خط: اصلاح پیکان ها، سبک خط، پهنا، رنگ و شفافیت پس زمینه–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

زمانی یک چارچوب انتخاب شده باشد2 این2 تابلوها ظاهر می شوند:

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

 که  چهار تابلو دارد:صفحه استحاوی ابزارهایی برای قالب‌بندی مستقیم (:Pageدسته صفحه)

(:اصلاح اندازه،پهنا، ارتفاع،جهت و حاشیه های صفحه.Formatقالب)–

سبک‌ها: اصلاح سبک شماره گذاری صفحه، پس‌زمینه، چیدمان	 و تعداد ستون‌ها.–

(:فعال/غیرفعال	 کردن سرصفحه و اصلاح حاشیه ها، فاصله ها و محتویاتHeaderسرصفحه)–

 اصلاح حاشیه ها، فاصله ها و محتویاتپاورقی و (:فعال/غیرفعال	 کردن	 Footerپاورقی)–

احتیاط

 تغییراتی که در گزینه های دسته صفحه، شما س22بک ص22فحه در ح22البا آگاه باشید 
استفاده را تغییر خواهید داد، اصلاح نه فقط برای ص22فحه ج22اری بلک22ه ب22رای هم22ه2

صفحاتی است که در این سند از این2 سبک استفاده می کنند2.

مدیریت سبک‌های استفاده شده در(: Styles and Formattingدسته سبک‌ها و قالب بندی)
سند2، اعمال سبک‌های موجود، ایجاد سبک‌های جدید یا اصلاح آن‌ها.
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 نگارخان22ه. نگارخان22ه دو بخشتم‌ه22اینمایش تصاویر و نمودارها در (:�� Galleryدسته نگارخانه)
تم ها بر اساس نام )پیکان‌ها، گلوله ها، نمودارها و غیره( و دومی نم22ایشدارد: اولی فهرست هایی از 

تصاویر مربوط به تم انتخابی.

کاوش سند و تشخیص محتوای آن بر اس22ای انتخ22اب دس22ته2 بن22دی(:Navigatorدسته ناوبری)
برای اطلاعات بیشتر کار ب22ا ن22اوبری درمحتوا از قبیل سرفصل‌ها، جدول‌ها، قاب‌ها، تصاویر و غیره. 

صفحات بعد را مطالعه بفرمایید.

نمایش همه ویژگی‌ها سبک‌های بند، سبک‌های نویسه،(:Style Inspectorدسته بازرس سبک)
و قالب بندی دستی متن انتخاب شده.

نوارابزارها
لیبره آفیس دو نوع جایگاه نوارابزار دارد: ثابت و شناور.در حالت ثابت نوارابزارها می تواند به جاهای
مختلفی جابجا شود)مثلا بالا، پایین یا کنار فضای کاری( و حتی شبیه2 یک پنجره مس22تقل،  ش22ناور در

هر جای صفحه که خواستید قرارگیرند یا دوباره در قسمتی از صفحه، ثابت شوند.

آشکار یا پنهان کردن نوارابزارها
 بروی22د و روی ن22ام ه22ر← نم��ا نواره��ای اب��زاربرای2 آشکار یا پنهان کر2دن نوارابزارها، از نوار منو به

نوارابزاری که مدنظر دارید کلیک کنید تا با علامت دار شدن ی22ا برداش22تن علامت آن ن22وارابزار ب22ه
هدف خود برسید.

برای2 مخفی کردن یا به اصطلاح بستن نوارابزار راه دیگری هم وجود دارد و آن کلیک راس22ت ک22ردن
 که2 آخرینه گزینه از منویی است که باز  می بستن نوارابزار�روی فضای بین د2و آیکن و انتخاب گزینه

شود.

نوار ابزارهای پرکاربرد
(۱در  لیبره آفیس به طور پیش فرض اولین نوارابزاری که زیر نوارمنو دیده می ش22ود)2ش22کل ش22ماره 

نوارابزار استاندارد2 خوانده می‌شود.
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( است که اگر شکل یاFormatting toolbarدومین نوارابزار پرکاربرد در بالا نوار ابزار قالب بندی) 
تصویر انتخاب2 شود مخفی می شود و نوارابزار ویژگی های مربوط به تص22ویر ی22ا ش22کل نم22ایش داده

می‌شود.

برای داشتن فضای بیشتر می توانید همان طور که قبل تر گفته شد این دو ن22وارابزار را ببندی22د و ب22ه
← نما  نوار ابزارها  جای آن از منوی ←standard(single mode) را انتخاب کنید که شامل

ابزارهای پرکاربردتر این دو نوار ابزار2 است.

زیرمنوها و جعبه ابزارها
شمایل‌های2 روی نوار ابزار که مثلث کوچکی کنارشان2 است زیرمنو یا جعبه ابزار  بیشتری مرب22وط ب22ه

آن ابزار دارد.

یک جعبه ابزار  مجموعه‌ای از ابزاره2ای ضمیمه به یک ابز2ار است مثلا وقتی روی مثلث کوچک ابزار
شکل بزنید جعبه ابزار شامل انواع اشکال مشاهده خواهدشد. یک جعبه ابزار را هم22ان ط22ور ک22ه در

 می‌بینید می توان  به عنوان یک نوار ابزار شناور باز نگه داشت. جعبه اب22زار ج22دا ش22ده ن22یز۴شکل 
دارای نوار عنوان است و  می توانید2 شبیه دیگر نوارابزارها آن راجابه جا یا  ثابت کنید.
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جابه‌جایی نوارابزارها
می توان22د ب22ه2 متصل در همان ح22الت هرچند می تواند از حالت ثابت خارج شود، ثابتنوارابزارهای 

 جابجا شود. چپ یا راست

برای2 جداکردن نوار ابزار:

 نشان داده شده۵نشانگر موشی را روی دستگیره‌های نوارابزار ببرید)نوار عمودی کوچک ابتدای نوار ابزار که در شکل (1
است(

دکمه کلیک را پایین نگه دارید و نوار ابزار را به محل جدید بکشید.(2

دکمه موشی را رها کنید.(3

برای2 انتقال نوارابزار شناور-شبیه سایر پنجره ها-روی نوار2 عنوان کلیک کنید و به محل دیگر بکشید
یا اگر خواستید آن را به بالا یا پایین پنجره اصلی متصل کنید.

یادداشت

شما همچنین می‌توانید برای ثابت یا به عب22ارتی متص22ل ک22ردن ن22وارابزار، روی ن22وار
عنوان آن دوبار کلیک کنید.

نکته

اگر دستگیره‌های نواراب2زار دیده نمی‌شود موقعیت آن قفل شده است.برای بازکردن،
Lockقفل کردن� موقعیت نوارابزار)روی2 آن کلیک راست کنید و سپس گزینه 

Toolbar Position).را از حالت انتخاب خارج کنید 
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: دستگیره‌های نوارابزار۵شکل 

خط‌کش‌ها
خط‌کش افقی در عرض بالای فضای کاری به طور پیش‌فرض مشاهده می‌شود2 اما خط‌کش عم22ودی

نما < خط‌کش‌ه��ا)به2 طور پیش‌فرض مخفی است. برای فعال کردن خط‌کش عمودی، از نوار منو، 
Rulersابزار‌ه��ا < گزینه‌ه��ا… <  ی22ا از را انتخ22اب کنید ( < خط‌کش عم��ود�ی LibreOffice

Writer > خط‌کش عمودی)نما ،Virtual rulerیا مخفی ( را علامت بزنید.برای به سرعت ظاهر 
 استفاده کنید.Ctrl+Shift+Rکردن هر دو خط‌کش از کلید ترکیبی 

نکته

دارد؛ اگ22ر ب22رایود ( در انتهای خcommentsخط‌کش افقی یک دکمه توضیحات)
برخی بخش‌های سند توضیح د2رج شده باشد با کلی22ک روی این دکم22ه ب22ه2 س22رعت

قسمت توضیحات مخفی یا آشکار می شود.

نوار وضعیت
نوار وضعیت رایتر در پایان فضای کاری قرار دارد و اطلاعاتی درباره سند و راه‌های راحتی بر2ای تغییر
سریع برخی ویژگی‌های سند فراهم می کند. این نوار می تواند از منوی نما با خارج کردن از انتخاب،

مخفی شود.

کلیدهای میانبر محیط کار
 کلید‌های میانبریدر لیبره آفیس هم شبیه سایر برنامه هابرای دسترسی ساده تر و سریع تر به فرامین

تا بدون نیاز به حرکت موشی بتوانید سریع تر ف22رامین م22دنظر خ22ود راهم در نظر گرفته شده است. 
(Save در لیبره آفیس و بیشتر برنامه‌های ک22اربردی کلی2د می2انبر ذخ2یره)Ctrl+sاجرا کنید. مثلا 

است.

کلید میانبر فرامینی که در منوها مشاهده می شود رو به روی نوشته شده است.
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یادداشت

در رابط کاربری فارسی کلیدهای کنترلی صفحه کلید هم ترجمه ش22ده ان22د! مثلا ب22ه
Shift در نام کلیدمیانبر کلمه مهار را مش22اهده خواهی22د ک22رد.)ب22ه ج22ای Ctrlجای 

 دگرساز.Altتبدیل  و به جای 

نکته

و حرف زیرخط دار منو یا زیر منوی مربوطه می توانید ب2ه آن  Alt با فشردن کلید 
  را برایFile  هم منوی F  و Altمنو دسترسی داشته باشید. مثلا فشردن  کلیدهای 

شما باز می کند و فشردن حرف2 زیر2 خط دار زیرمنوها مش22ابه کلی22ک روی آن عم22ل
خواهدکرد.

Altدر صفحه کلید استاندارد فارسی 

(Altبرای نکته قبل در هنگام فارسی بودن صفحه کلید ممکن اس22ت فق22ط دگرس22از)
سمت چپ کار کند چراکه در صفحه کلید استاندارد فارسی کلید2ها سه حالت دارند،

( فشرده شوند که معمولا برای اعراب وShift حالتی که با تبدیل)۲: حالت عادی، ۱
(س22مت راس22تAlt حالتی ک22ه ب22ا دگرس22از)۳علایم)ویرگول و …( استفاده می شود، 

فشرده شوندکه در این حالت می توان علائم لاتین را بدون لاتین کردن صفحه کلید
ظاهر کرد یعنی بدون این که برای نوشتن@ بدون این که صفحه کلید را لاتین کنید

 را بنویسید و دوباره صف2حه کلید را فارس22ی کنی22دعلامت این ۲ ‌و عددShiftو بعد با 
 به سادگی این کار را انجام دهید.۲ سمت راست و عدد Altمی توانید با 

ایجاد سند جدید خالی

شما از چندین طریق می‌توانید یک سند جدید2 یا خالی در رایتر ایجاد کنید. 
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از مرکز شروع
 (دیده می شود.۶هنگامی که لیبره آفیس باز است اما سندی باز نیست، مرکز شروع)شکل شماره

 کلیک کنید تا یک سند2 متنی ایجاد شود؛2 البته همان طورCreate: Writer Document روی 
قالبیتا  هم  می توانید کلیک کنید Templates بیشتر توضیح داده خواهدشد روی  کمی بعد، که 

غیر از قالب پیش فرض برنامه برای سند جدیدتان انتخاب کنید.

نوار منو، نوارابزار یا صفحه4 کلیداز 
اگر رایتر باز باشد شما از سه راه دیگر می توانید سند جدید ایجاد کنید:

Ctrl+Nفشردن کلید ترکیبی •

 (از نوار منوFile > New > Text Document ) متنینوشتارپرونده < جدید < انتخاب •

 روی نواراب	زار استاندارد(New icon جد,ید, )کلیک روی شمایل •
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(Template موجود)الب‌هایایجاد سند جدید بر اساس ق

(است. ق22الب،Templateیکی از قابلیت‌های رایتر برای تسریع در کارهای تکر2اری استفاده از قالب)
 متن، قالب بندی، سبک، تصاویر پس زمین22ه ومجموعه‌ای از پرونده ای ویژه‌ای2  است که  می تواند 

 قابل استفاده است)شبیهمشابه باشد و مثل یک فرم2 خام برای2 کارهای مشابه  یا تکراری سایر موارد 
قابل استفادهنامه‌های اداری با سربرگ مشخص(.  سبک‌ها و تنظیماتی است که در ایجاد سند جدید 

.مزیت استفاده از قالب برای ایجاد س22ند جدی22د این اس22ت ک22ه تنظیم22ات و ط22راحی ظ22اهریاست
سند2جدید مشابه قالب انتخاب شده است و نیاز به طراحی و تنظیمات مج2دد نیست.

برای2 بازکردن پنجره قالب‌ها، به این یکی از این روش‌ها اقدام کنید:

Ctrl+Shift+Nاستفاده از کلید میانبر  •

< File > Templates < مدیریت قالب‌ها از نوار منو)Templatesانتخاب پرونده < •

Manage Templates)

(File > New > Templatesانتخاب پرونده < جدید < قالب‌ها از نوار منو)•

( روی ن22وارا2بزار اس22تاندارد وNew iconکلی22ک روی مثلث کوچ22ک ش22مایل جدی22د)•
Templatesانتخاب  ...

 قالب های مربوط به نوشتار)سندهای های مت22نی( مش22خص۷نمونه نشان‌داده شده در شکل شماره
است. کافیست روی قالب دلخواهتان دوبار کلیک کنید تا سندی با آن قالب ایجاد ش22ود. همچ22نین

 کلیک کنید.(Openبازکردن)می‌توانید یک قالب انتخاب کنید و روی دکمه 
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مدیریت اسناد

پس از اسند جدید و تکمیل آن، لازم است یجاد یک اسنادی که در سند را ذخیره کنیم ی22ا ببن22دیم.
همچنین ممکن است در آینده بخواهیم مجددا نوشتار را در رایتر باز کنیم.

ذخیره کردن سند
Save ذخ��یره� ب��ا عن��وان...) یا فرمان(Save ذخیره)شما می‌توانید یک نوشتار را با فرامین  as)

ذخیره کنید.
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فرامین ذخیره سازی

ذخیره پرونده4 جدید یا پرونده از قبل ذخیره شده
یکی از کارهای زیر را انجام دهید:

.Ctrl+Sفشردن •

(File > Save از نوار منو) پرونده < ذخیرهانتخاب•

 ( روی نوارابزار استاندارد.Save icon)ذخیرهکلیک روی شمایل •

نکرده باشید، با انجام هر یک از گزی2نه‌های فوق،2 پنجره ذخیره به عنوان) نوشتار جدیدتان ذخیره  اگر
Save  as( باز می شود. نامی برای پرونده وارد کنید2و از نوع)پسوند( و محل ذخ22یره س22ازی آن را

 کلیک کنید.ذخیرهبازبینی کنید و روی 

پس از این که سند را ذخیره کردیم، ممکن است مجددا تغییراتی را در آن اعمال کنیم. به22تر اس22ت
چر چند دقیقه  یکبارسند را ذخیره کنیم تا در صورت ایجاد مشکلی مانند قطع شدن برق، تغی22یرات

داده شده از بین نرود.

برای2 ذخیره پرونده جاری نیز به همان ترتیب گفته شده عمل می کنیم:

.Ctrl+Sفشردن •

(File > Save از نوار منو) پرونده < ذخیرهانتخاب•

 ( روی نوارابزار استاندارد.Save icon)ذخیره کلیک روی شمایل •

بدیهی است اگر نوشتار را از قبل ذخیره کرده باشید پس از انجام هر یک از گزینه‌های بالا، برای ن22ام
 نیست و پرونده با همان نام و نوع در هم2ان مح2ل فعلیاضافه تریو نوع و محل پرونده نیاز به کار 

ذخیره خواهد2شد.

پرونده جاری

سندی  که هم اکنون در داخل آن2 قرار داریم و نام آن در نوار عن22وان)ب22الای پنج22ره(
مشخص است را پرونده جاری می‌گوییم
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(Save a copyذخیره یک رونوشت)
وقتی استفاده کنید که می‌خواهید سند فعلی باز بماند و و رونوش22ت جداگان22ه2 ای هم2 ازاز این دستور 

نگارش فعلی ذ2خیره کنید.

Save As را که انتخاب کردید، پنجره محاوره‌ای Save a Copyوقتی از نوار منو،  پرونده <  ...

ظاهرشد، نام، نوع و محل را وارد2 یا تایید کنید2 و سپس روی ذخیره کلیک کنی22د. رونوش22ت ذخ22یره
شده باز نمی شود و پرونده اصلی باز و فعال باقی  می‌ماند.

ذخیره همه
این فرمان همه پروند2ه های باز را ذخیره می‌کند.

را انتخاب کنید تا بدون تغییر در نام، نوع یا( File > Save All پرونده < ذخیره همه)از نوار منو،
محل ذخیره‌سازی همه پروند2ه‌های باز  ذخیره شوند.

(Save asذخیره به عنوان )
 جدید با نام یا نوع یا محل ذخیرهسند2ی فعلی را به عنوان2 نگارش گاهی اوقات ممکن است بخواهیم

سازی دیگری ذخیره کنیم. برای این کار به صورت زیر عمل می‌کنیم:

File پرونده < ذخیره به عنوان)از نوار منو،   >  Save  As )را انتخ2اب کنی2دیا کلی2د می2انبر
Ctrl+Shift+S را بزنید تا پنجره ذخیره باز شود، سپس نام یا نوع یا محل جدید را مشخص کنید و

در نهایت روی ذخیره کلیک کنید.

(Save as ) و ذخیره به عنوان(Save a copy)فرق ذخیره رونوشت

وقتی ذخیره به عنوان را انتخاب می کنید نگارش فعلی جداگانه ذخیره خواهد شد با
این تفاوت که پرونده اصلی با آخرین ذخیره‌سازی قبلی بسته می‌شود و سندی که باز
است در واقع سند جد2ید ذخیره شده است.اما در ذخیره یک رونوشت همان طور که
گفته شد تغییرات تا آن لحظه در پرونده ای دیگر ذخیره می شود ب22دون این‌ک22ه ب22از

شود و شما می توانید2 ادامه تغییرات2 را شما در پروند2ه اصلی انجام  دهید.
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یادداشت

PDFلیبره آفیس از عبارت »صدور« برای خروجی گرفتن در قالب‌های دیگر مانن22د 

 استفاده می‌کند.ePubو 

بازکردن سند
 از چندین راه می توانیم2 اسناد موجود را باز کنیم، از جمله:

 از مرکز شروعRemote files ا  یOpen File  کلیک روی •

 از نوار منو.File > Open Remote یا ( File > Open.)   پرونده < بازکردن..انتخاب•

.Ctrl+Oفشردن  •

روی نوار ابزار استاندارد.( Open iconکلیک روی شمایل بازکردن)

 را مش22خص می ک22نیم ودر صورت نیاز محل و نوع پرون22دهد، ابتدا شهنگامی که پنجره بازکردن باز
 کلیک می‌کنیم. بازکردن�سپس پرونده مورد را انتخاب و در نهایت روی دکمه2 

برای2 باز کردن سندیی که اخیرا در رایتر باز شده باشد روش های ساده تری هم هست:

کلیک روی تصویر بند انگشتی سند نظر را در صفحه شروع•

 < از نوار منو و انتخاب سند مورد نظرپرونده < بازکردن نوشتار‌های اخیرانتخاب •

( روی نوار ابزار استاندارد.Open iconکلیک روی مثل کوچک روبه پایین کنارشمایل بازکردن)•

(Switch Windowsتعویض پنجره فعال یا پرونده جاری)
همان طور که می دانید فقط یک پرونده جاری می توانیم داشته باش22یم یع22نی همزم22ان نمی ت22وانیم

 توانیم از من22ویمی چندین سند باز نیازمند ویرایش باشد  مشغول نوشتن در چندسند باشیم.اما اگر
در نوارمنو، فهرست پنجره‌های باز را ببنیم و سند مورد نظر خود را انتخ22اب ک22نیم ت22ا پنج22رهپنجره� 

فعال ما شود.

بستن سند
برای2 بستن پرونده جاری یکی2 از روش های زیر را به کار می بریم:

25 | مدیریت اسناد

 را انتخاب می کنیم.بستناز نوار منو، •

  را می فشاریم.Ctrl+wیا کلید میانبر •

  را می فشاریم.Alt+F4یا کلید میانبر •

  روی نوار عنوان کلیک می کنیم.Xیا روی  دکمه کنترلی  •

 را انتخاب می‌کنیم.بستننوار عنوان کلیک راست می کنیم و از منوی ظاهرشده یا بر روی •

 ک22ه میگر تغییرات داده شده را ذخیره نشده باشد، در هنگام بستن پرونده، اخطاری داده می ش22ودا
کلیک کنید.ذخیره یا عدم ذخیره یا انصراف از بسته شدن پرونده توانید روی دکمه 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۲فصل 
ویرایش سند

 روش‌های نمایش سند

رایتر سه شیوه کلی برای نمایش و ویرایش یک سند دارد: عادی، وب و تمام صفحه. برای تغییر نما،
از منوی نما روی نمایی که نیاز داریم کلیک می‌کنیم.

نما یا در‌واقع پیش‌نمایش چاپ هم نمای دیگری2 است که2 البته غیرقابل ویرایش است که می‌ت22وانیم
( فعال کنیم.File > Print Preview)آن را از پرونده < پیش‌نمایش چاپ

(Normal viewنمای عادی)
نمای عادی، نمای پیش‌فرض رایتر است که سند را همان طور که قرار است چاپ یا پی دی اف شود

نشان می‌دهد.

می‌توانیم سرصفحه و پاورقی و سایر فض22اهای خ22الی بین ص22فحات رادر نمای عادی در صورت نیاز 
از نوار منو برداشته  Show Whitespace نما <  مخفی کنیم؛ برای این کار علامت انتخاب از

شود.

نکته

Single-pageنمای تک صفحه ای)  Viewچند صف2حه ای ب22ا توج22ه ب22ه ان22دازه ،)
Multiple-pageصفحه نمایش و بزرگنم22ایی فض22ای ک22اری )  View(و کت22ابی )

Book Viewهم نماهای عادی هستند2 که با کلیک روی ش22مایل مربوط22ه روی )
نوار وضعیت در کنار ابزار بزرگنمایی قابل استفاده هستند.

نمای وب
 آن را در مرورگر2 اینترنتی در حال مشاهده هستیم. گویانمای وب سند را آن طور نشان می دهد که 
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نمای تمام4 صفحه
در این2 نما، نوار ابزارها و نوارجانبی وجود ندارد؛ سند تمام ناحی22ه را پ22ر2 می کن22دو البت22ه  ب22ر اس22اس

تم22ام ص22فحه ازبزرگنمایی  و چیدمانی که در نمای عادی انتخاب شده ب22ود. ب22رای رف2تن ب22ه نم22ای 
  کلی22دیا برای خروج از این نما هم می توانیم می کنیم و  استفاده  Ctrl+Shift+Jکلیدهای‌ میانبر 

Esc.2را بفشاریم یا کلیدها را یک بار دیگر بفشاریم  

انتخاب کردن متن

برای2 انجام کارهای ویرایشی بر روی متن، لازم است ابتدا متن مورد نظر را با موشی یا ص22فحه کلی22د
انتخاب کنیم.

انتخاب متن

(قسمتی از متن برای ویرایش، قالب‌بندیHighlight کر2دن)رج2سته یا درخشانبه ب
یا رونوشت گرفتن و … از آن، انتخاب کردن متن می‌گوییم.

(paragraphبند)

‌ از هم جدانشده اند، بند می‌گوییم.Enterبه عبارات یا جملات پشت سر هم که با 
به عبارت ساده با نقطه سرخط یک بند به پایان می رسد.

 انتخاب متن2 در رایتر شبیه انتخاب متن در دیگر برنامه های ک22اربردی اس22ت. می ت22وانیم نش22انگر
 مورد نظر ببریم و چندبار کلیک کنیم برای انتخاب یک کلمه)دوبار کلیک(، ی22کمتنموشی را روی 

جمله)سه2 بار کلیک( و یک بند)چهاربار کلیک(.

 و هم استفاد2ه کنید.ctrl و shiftباز هم شبیه انتخاب در برنامه‌های دیگر می‌توانیم از کلیدهای 

ج22ایی  را نگهداشته ایم به کمک کلیدهای جهتی)بالا-پایین-چپ-راست( یا اگ22ر shift وقتی دکمه 
همچ22نین م22ادیگری از متن کلیک کنیم فاصله بین کلیک جدید و مح22ل قبلی انتخ22اب خواهدش22د.

افزایش استفاده کنیم تا با کلیک محدوده انتخاب را shift به جای نگه داشتن f8می‌توانیم از کلیک 

29 | انتخاب کردن متن

Extended  حالت انتخاب در‌واقع به حالت انتخ2اب افزایش2ی)f8دهیم. با   selectionتب2دیل)
 دوباره، حالت انتخاب را به حالت استاندارد انتخاب بر می گرداند.f8می‌شود و 

 را۸یک راه برای تغییر حالت‌های انتخاب استفاده از شمایل مربوطه در نوار وضعیت اس22ت.)ش22کل 
ببینید(. موقعی ک2ه2 روی آن کلی2ک راس2ت ک2نیم من2ویی ب2از می‌ش2ود ک22ه گزینه‌ه2ای مختلفی در

 ‌عم22لshift ک22ه مش2ابه  f8دسترسمان قرار می دهد.ا2نتخاب استاندارد،2 انتخ2اب افزایش22ی)کلی22د 
( و انتخ22اب بل22وکی) عم??ل می کندctrl مش?ابه نگ?ه داش?تن Shift+F8می‌کرد، انتخ2اب اض2افه)

Ctrl+Shift+F8که  به? ما امکان انتخاب متن  چند نویسه یا کلمه از ابتدا، میانه ی??ا انته??ای چن??د 
خط می دهد(

غیر پیوسته قسمت‌هاانتخاب 
 پس از انتخاب اولین قطعه متن به2 کمک موشی،۹برای انتخاب قسمت‌های غیرپیوسته2 شبیه شکل 

Ctrl را پایین نگه می‌داریم و  قطعه متنی دیگر را انتخاب می کنیم. به جای نگ22ه داش22تن ctrlدکمه 

م تا2 چند متن را بتوانیم همزمان انتخاب کنیم. استفاده کنی‌Shift+F8هم می‌توانیم از  
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Addnig حالت انتخاب کردن از استاندارد به حالت انتخاب اض22افه)Shift+F8با    Selection)
تغییر خواهد کرد و فشردن مجدد آن انتخاب را به حالت استاندارد برمی‌گرداند.

انتخاب بلوک عمودی متن
از حالت انتخابی بلوکی رایتر می توانیم بلوکی از متن ها را از چند چند سطر انتخاب کنیم. ب22رای این

selectionوایریش < کار می توانیم از منوی   mode(  ی22ا کلی22د۸ یا نوار وضعیت)شکل ش22ماره
  وshift، با کمک موش22ی ی22ا ۱۰ حالت بلوکی را انتخاب کنید و شبیه شکل ctrl+shift+f8ترکیبی 

دکمه های جهتی صفحه کلید بلوکی از  متن2 را انتخاب کنید.

31 | انتخاب کردن متن

: انتخاب غیر پیوسته قسمت ها۹شکل 

 متنسباندنبرش، رونوشت و چ
برید2ن و رونوشت متن در رایتر شبیه برش و رونوشت متن در برنامه های دیگر است. م22ا می‌ت22وانیم
متن انتخاب شده ای را با کشیدن با موشی، کلیک راست، شمایل مربوط22ه ی22ا کلی22دهای می22انبر  در
داخل سند یا بین اسناد رونوشت یا جابجا کنیم. همچنین می توانیم از دیگر منابع مثل صفحات وب

متنی را رونوشت بگیریم و آن را در سند رایتر بچسبانیم.

 جدید بکشید و رها کنید.محل موشی استفاده کنید و آن را به از )کشیدن و رها کردن(ابجایی متن انتخاب شدهبرای ج•

 نگ	هدارید.هم را در Ctrlبرای رونوشت متن انتخاب شده، ضمن کشیدن، کلید •

 را  برای بریدن متن استفاده می‌کنیمCtrl+X)بریدن و جایگذاری در محل جدید(، برای جابجایی متن انتخاب شده•
 متنچس		باندن ب		رای Ctrl+Vو سپس مکان نما را در نقطه‌ای که قرار است جای‌گذاری ک		نیم ق		رار می دهیم  و از 

استفاده کنید. روش دیگر استفاده از دکمه‌های نوارابزار است.

( استفاده می‌کنیم قالب و س22بک مب22دا)مثلا ن22وع و ان22دازهpasteوقتی به طور معمول از چسباندن)
قلم( هم حفظ می‌شود.2
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می دهیم( را ب2هبرای2 اینکه متن جابجا شده، قالب‌بندی و سبک متن مقصد)جایی که در آن‌ج2ا ق2رار 
:خود بگیرد

 را انتخاب می‌کنیم یاPaste Specialاز ویرایش <  •

 نوار ابزار  کلیک می کنیم یا( Paste Iconچسباندن) مثلث کوچک کنارروی •

 تازیرمنوها دیده شود یا می‌داریمکلیک موشی را نگه  چسباندن، از نوار ابزار روی شمایل•

•Ctrl+Shift+V.را می زنیم  

.می‌کنیم( را از منو نتایج انتخاب Unformatted text )بدون قالب متن سپس

نکته

بچسبانیم.  Ctrl+Alt+Shift+Vمی‌توانیم متن را بدون قالب مبدا، در مقصد با زدن  

جستجو و جایگزینی متن

 برای اولین روش ب2رای جس2تجو اس22تفاده از ن2وارابزار برای جستجوی متن در سند دو راه دارد:رایتر
 است. Find & Replace( است و روش دیگر استفاده از پنجر2ه محاوره‌ای Find)جستجو

جستجو استفاده از نوارابزار 
پنج22ره برنامه مشاهده می‌شود، پایین ۱۱به2 طور پیش‌فرض نوارابزار جستجو، همان طور که در شکل

 توض2یح داده ش2د امک2ان۱)درست بالای نوار وضعیت( مش2اهده می‌ش2ود؛ هم22انطور ک2ه در فصل
اگر این نوار ابزار را نمی‌بینید نگ22ران نباش22ید می‌ت22وان آن را از. وجودداردجابجایی و شناور کردن آن 

 ظاهرکرد.Ctrl+F  یا (View > Toolbars > Findنما < نوارابزارها < جستجو )منوی 

33 | جستجو و جایگزینی متن

: نوارابزار جستجوی پهلوگرفته در پایین پنجره۱۱شکل 

 ب22زنیم. ازEnter ورودی بنویس22یم و ک22ادر افیس22ت آن را در ، ک متن یا عبارت متنیبرای جستج2و
 نیز می توانیم آن را اگر در موقعیتFind Previous یا Find Nextهای بالا و پایین ‌طریق دکمه

( نشان می دهد.Highlight هم همه2 یافته ها را برجسته)Find All2های قبلی یا بعدی پیدا کنیم. 

خفی کردن این نوار ابزار  چندین راه دارد از جمله:2م

 ابتدای نوار اب	زارX دکمهکلیک روی •

 در زمانی که در کادر جستجو قرار	 داریمEscزدن •

 Find & Replaceاستفاده از پنجره محاوره‌ای  

( از روش های زیر اقدام می کنیم:۱۲شکل   )Find & Replaceبرای نمایش کادر محاوره‌ای 

 Ctrl+Hکلیدهای میانبر •

.می‌کنیمرا از از نوارمنو انتخاب  Edit > Find & Replace ویرایش <...•

 روی نواراب	زار جستجو Find & Replaceکلیک روی دکمه  •
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Otherهنگام باز بودن این کادر محاوره ای روی این اختیار را داریم که   Optionsکلیک کنیم ی22ا 
(را ببینید ۱۲شکل ). امکانات جستجو را گسترش دهیم

برای2 استفاده از کارد2 محاوره‌ای جستجو و جایگزینی به ترتیب زیر عمل می کنیم:

 می نویسیمFindمتنی که می‌خواهیم جستجو کنیم را در کادر (1

 می‌نویسیمReplaceبرای جایگزینی آن متن با متنی دیگر، متن جدید را در کادر (2

)match case. مانند می‌کنیم گزینه‌های مختلفی را انتخاب ر صورت نیازد(3  بزرگی ی		ا ک		وچکی ح		روف	تطابق با 
 کل کلمات یعنی متن مورد جستجو جزیی از یک کلمه نباشد مثلافقط )whole words onlyانگلیسی( یا  

اگر دنبال	 کلمه »دانش	 آم		وز«  هس		تیم دانش	 آم		وز در کلم		اتی مانن		د»دانش آم		وزان«، »دانش	 آموزه		ا« ی		افت نش		ود(.
: جستجو فق		ط در متن انتخ		اب ش		ده، جس		تجو از م		وقعیت فعلیمثلهمچنین گزینه‌های دیگر هم  در دسترس است 

. سندمکان نما به عقب به سمت ابتدای 

یادداشت

در مثال جستجوی »دانش آموز« فقط در کلمات کامل، اگر »دانش آموزها« با فاصله
بین دانش آموز و ها به2 صورت »دانش آموز ها« نوشته شده باشد2 کلم22ه دانش آم22وز

کلمه کامل و جدا از کلمه2 بعدی به2 نظر خواهد رسید و در نتایج خواهد آمد.

داده خواهدش		د و در نم		ایش اگر نتیجه ای یافت ش		ود ب		ه ص		ورت برجس		ته	، می‌کنیم کلیک Find Next بر روی (4
 متن جدید جایگزین کنید.Replace با کلیک کردن بر روی صورت نیاز به جایگزینی

نکته

Replaceاز نیاز به مشاهده موردی نتایج نداریم با کلیک روی    Allهمه2 نتایج ب22ا 
متن موردنظرمان جایگزین خواهد شد.

هشدار

 باید با احتیاط و دقت و اطمینان استفاده کنیم چراکه اگر سند راReplace Allاز  
ذخیره  و بسته شود؛ دیگر قابل بازگشت به2 حالت قبل نخواهدبود.

35 | جستجو و جایگزینی متن

درج نویسه‌های ویژه

 ¢æ ç Ł ñ ö ø ©2 ¾2 نویسه‌های ویژه مواردی است که در صفحه کلید پیدایشان نمی کنیم مثلا
. همگی نویسه‌های ویژه هستند

برای درج یک یا چند نویسه ویژه، نشانگر را در موقعیتی که می خواهیم نویسه ها ظاهر ش22وند ق22رار
می‌دهیم و به یکی از روش های زیر اقدام می کنیم:

Special نویسه ویژه)روی شمایل•  Character )تی از		نیم تافهرس		ک می ک		تاندارد کلی		زار اس	روی نواراب 
را۱۳نویسه های برگزیده یا اخرا استفاده شده باز شود و برای درج، روی هر کدام که خواستیم کلیک می کنیم) ش		کل 

 ک		ادرMore Characters(.همچنین می توانیم در انته		ای فهرس		ت بازش		ده،  ب		ا کلی		ک روی دکم		ه  ببینید
( را بازکنیم.۱۴محاوره‌ای نویسه‌های ویژه)شکل

Insert > Special درج < ... کلی		ک روی من		وی•  Character  	دن		از  ش	رای ب		اوره‌ای ب		ادر مح		ک
( و سپس دوبار کلیک روی نویسه‌هایی ]از هر قلم یا ترکیبی از قلم‌ه		ا[ ک		ه  می‌خ		واهیم درج۱۴نویسه‌های ویژه)شکل

شود. نویسه‌هایی که انتخاب کردیم در سند درج می‌شود و همچنین به فهرست نویسه‌های اخیرا استفاده ش		ده اض		افه
می‌شوند.

 نویسه های ویژه مختلف هستند. اگر نویسه2 ویژه به خصوصی را پیدا نکردیمشاملقلم‌ه2ای مختلف 
را باید امتحان کنیم.لازم است قلم های دیگر 
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نکته

 برای مشاهده جزی2یات نویسه یک‌بار روی آن کلیک می کنیم تا جزییات آن از جمله
کدعددی آن مشاهده شود.

با دوبار کلیک روی نویسه مد نظر، نویسه مدنظر درج می ش22ود و ک22ادر مح22اوره‌ای
نویسه های ویژه همچنان باز می‌ماند. اما اگر روی نویسه مدنظر ]ی22ک ب22ار[ کلی22ک

 را بز2نیم؛ نویسه2 درج و پنجره بسته می شود.Insertکنیم و سپس دکمه 
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: کادر محاوره ای نویسه های ویژه۱۴شکل 
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۳فصل 
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مقدمه

وقتی یک متن ساده را در رایتر می نویسیم ممکن است از لحاظ ظاهری زیب22ا ب22ه نظ22ر نرس22د و لازم
است به2 کمک قالب‌بندی، ظاهر متن را به گونه‌ای تغییر دهیم تا زییایی و خوانایی مورد نیاز را داشته

باشد2. این فصل، اصول قالب بندی متن در رایتر را پوشش می‌دهد، مفاهیمی از قبیل:

قالب‌بندی بندها و نویسه‌ها•

قالب‌بندی دستی و سبک‌ها•

استفاده از قالب‌بندی خودکار•

ایجاد	 فهرست‌های گلوله‌ای، شماره دار یا طرحواره ای•

 توض22یح داده ش22ده اس22ت،۲در این2 فصل فرض بر این است که2 با تکنیک‌ه22ای مت22نی ک22ه در فصل
آشنایی داریم.

قالب‌بندی نویسه‌ها

ما می‌توانیم بعد از انتخاب متن)نویسه های( مورد نظر، قالب‌های متع22ددی ب22ه آن  اعم22ال ک22نیم.
مهم‌ترین ابزار‌های قالب‌بندی نویسه ها از طریق دکمه‌های نوارابزار قالب بند2ی  و با استفاده از پان22ل

نویسه ها در دسته خصوصیات نوار جانبی در دسترس هستند2 از جمله:

( و اندازه و جلوه‌های آنFont قلم)نوع•

(، زیرخط دار و…(Italic(، کج)Boldسبک نگارش قلم )توپر)•

رنگ قلم و پس‌زمینه آن•

نوع قلم، اندازه و جلوه‌ها
 را از راه های زیر می‌توانیم تغییر دهیم:نوع، اندازه، رنگ و جلوه ها و سایر ویژگی‌های قلم

 نوارابزار قالب بندیفهرست‌های کشویی قلم و اندازه و سایر دکمه‌های دراز  •

با استفاده از پانل نویسه ها در دسته خصوصیات نوار جانبی •
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پنجره محاوره‌ای قلم•

 قلم غیر از کشوی فهرست اندازه قلم روی ن22وارابزار قالب‌بن22دی، راه افزایش یا کاهش اندازهبرای
دکمه اف22زایش و ک22اهش ان22دازه قلم کلی22کدیگری نیز وجود دارد؛ می توانید از پانل نویسه ها روی 

( تغییر می دهد.Point نقطه)۲کنید2 که معمولا اندازه قلم را 

(Pointنقطه)

 اینچ۱/۷۲هر نقطه برابر است با 

تنظیمات روی محاوره‌ نویسه
( دارد.ک22ه در این بخش نش22ان دادهtab( ش22ش ص22فحک)زبان22ه یاcharacter نویس22ه)مح22اوره

می‌شود.برای باز کردن محاوره نویسه چندین راه وجود2 دارد:

 از روی نوار منو  Format > character قالب بندی < ... کلیک روی منوی•

character  از زیرمنوی characterکلیک راست روی متن انتخابی و انتخاب  ... •

 بازاست.Properties  نوار جانب، وقتی دسته Character پانل More Optionsکلیک روی چرخنده •

قلم، انداز، رنگ و جلوه‌های قلم
ج(، ع22ادی، ت22وپر، کشامل قلم، سبک)حالت های مختلف قلم نام( می‌توانیم ۱۵)شکل قلم زبانهدر 

 آن را مشخص کنیم.اند2ازه و زبان

‌ موارد مربوطCTL Font موارد مربوط به زبان2 لاتین و از قسمت western Text Fontقسمت 
به2 زبان فارسی را تنظیم می‌کنیم.

( نیز می‌توانیم رنگ قلم و طیفی از جلوه‌ها را انتخاب ک22نیم ک22ه البت22ه۱۶)شکل جلوه‌های قلم?از زبانه
برای مستندات رسمی چندان مناسب نیستند.
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موقعیت
در زبانه موقعیت می توانیم موقعیت نویسه ها را مشخص کنیم به این معنا که:۱۷مطابق با شکل 
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 محاوره نویسهاز قلم زبانه: ۱۵شکل 

: زبانه جلوه‌های قلم از محاوره نویسه۱۶شکل 

 اندیس هستند چند درصد اندازه قلم اصلی باشند.گر و اپایین  یا اندیس بالا یا اندیس باشندعادی •

 درجه باشند یا به عبارت دیگر عمودی باشند یا افقی) ۲۷۰ یا ۹۰، ۰دارای زاویه •

دی
(عمو

فاصله بین نویسه های وجود داشته باشد•

(HyperLinkفراپیویند)
 کلی22کبازبانه فراپیوند این امکان را با ما می دهد نشانی اینترنتی یا پرونده ای را مشخص ک22نیم ت22ا 

آن پرونده یا2 صفحه اینترنتی باز شود.روی نویسه‌های2 انتخاب شده،  

(HighLight)سازیبرجسته 
زبان2 برجسته کردن می توانیم شبیه ماژیک های فسفری، نویسه‌های مدنظرمان را با رنگی دلخواه،از 

برجسته کنیم، همان طور که قبلا هم گفته شد، انجام این2 کار از نوارابزار قالب‌بندی و نوار ج22انبی هم
امکان‌پذیر است)دکمه کنار رنگ قلم(
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حاش4یه‌ها
آخرین زبانه هم برای این که دور نویسه های خود به ترتیبی که م22دنظر داریم، حاش22یه‌ای ب22ا جل22وه

مدنظر خودمان اضافه کنیم. در مورد حاشیه ها در قسمت بندها توضیح بیشتر ارائه خواهد شد. 

قالب بندی بندها4

بندی بند نیاز به انتخاب بند نیست و تنها کافیست مکان نما در بند باشد. البته اگر چند2 برای2 قالب‌
بند را بخواهیم همزمان قالب‌بندی کنیم باز هم لازم است ابتدا حداقل بخش2ی از ه2ر دو را انتخ2اب

 می‌توانیم قالب‌های مختلفی را به بندها اعمال کنیم، مثلا با استفاده از:کرده باشیم.ما

شمایل روی نوار ابزار قالب‌بندی•

  نوار جانبیProperties از دسته Paragraphپانل •

 منوی قالب‌بندی نوار منودردستورات موجود	 •

گزینه‌های موجود در محاوره بند•

مهم‌ترین ابزار‌های قالب‌بندی نویسه ها از طریق دکمه‌های نوارابزار قالب بند2ی  و با استفاده از پان22ل
نویسه ها در دسته خصوصیات نوار جانبی در دسترس هستند2.

ترازبندی بند
توضیحات لازم اینجا اضافه خواهد2 شد

(Stylesقالب‌بندی: مستقیم)دستی( یا سبک‌ها)
دو گونه قالب بندی داریم که در ادامه توضیح داده خواهدشد.

 قالب‌بندی مستقیم]یا دستی[ 
اعمال قالب‌بن22دی ب22ه ط22ور مس2تتقیم روی بن22دهای خ2اص، نویس2ه‌ها، ص2فحات،قاب‌ه2ا،
فهرست‌ها یا جداول. به عنوان مثال می‌توانیم کلمه ای را انتخاب کنیم و سپس روی دکمه‌ای

 کنیم.( کلیکItalic(یا کج)Bold)از نوار قالب‌بندی، مانند توپر
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سبک‌ها
ه‌ای از گزینه‌های قالب‌بن22دی تحت عن22وان ی22ک ن22ام. ب22ه عن22وان مث22ال، س22بک بن22د2)بست

paragraph  styleمی تواند شامل تنظیمات معتددی مانن22د قلم، ان22دازه آن، فاص22له بین)
فاده کنیم با انتساب آن سبک ب22ه بن22دخطوط و غیره باشد که هرجای که خواستیم از آن است

خاص، همه تنظیمات یک جا اعمال می شود.

استفاده از سبک‌ها توصیه4 می‌شود
 از آنجا که سبک‌ها مجموعه2 ای از قالب‌ها را، همزمان اعمال می‌کند،‌ به ما این توانایی را می‌دهد ک22ه
قالب یک سند را منظم کنیم و با کم‌ترین زحمت، قالب‌بند2ی را در تمام سند اعمال ک22نیم. بن22ابراین
استفاده از سبک‌ها به2 شدت توصیه می‌شود. به علاوه این2 که2 استفاده از سبک‌ها قابلیت هایی مانن22د

فراهم می کند که ممکن است از آن مطلع نباشید.ایجاد خودکار فهرست مطالب را 

 صفحه‌ای را با نرم‌اف2زار رای2تر ت2ایپ و ص2فحه آرایی۲۰۰فرض کنید که می‌خواهیم یک کتاب مثلا 
کنیم؛ اگر به صورت معمولی از نرم افزار استفاده کنیم، بعد از تایپ کتاب اگر از ما خواسته شود قلم
یا رنگ بندی عناوین کتاب2 را تغییر دهیم، نیاز به صرف زمان زیادی دارد. یا اگر بخواهیم فهرس22تی
از مطالب کتاب به همراه شماره صفحه آن استخراج کنیم، کار طاقت فرسایی است به وی22ژه اگ22ر ب22ا

تغییر اندازه قلم ها یا اندازه صفحه و...، شماره صفحات تغییر کند.

( استفاده کرده باشیم2 همه این کار ها)به‌روزرسانی‌ها( با یک دستور بهStyle2اما اگر از قابلیت سبک‌)
( یا  چند کلیک ساده انجام می شود.updateروز رسانی)

اعمال سبک‌ها به طور آسان و سریع از دسته سبک‌ها در نوار جانبی امکان‌پذیر است.

احتیاط

 قالب‌بندی دستی ] که قالب بن22دی مس22تقیم هم خوان22ده می‌ش22ود[، س22بک‌ها را رد
ویت اعمال بالاتری دارد،2 به این معنا که اگر قسمتی را به طورمی‌کند یا به عبارتی اول

دستی قالب بندی کنیم،2 هیچ سبکی بر آن قسمت، اعمال نمی‌شود.
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حذف قالب‌بن4دی دستی
برای2 حذف قالب‌بندی دستی، متن2 مورد نظر را انتخاب می کنیم و:

 را انتخاب می‌کنیم یاFormat > Clear Direct Formatting  قالب‌بندی < از نوار منو •

 را انتخاب می کنیم یاClear Direct Formattingروی آن کلیک راست می‌کنیم و  •

 روی نوار ابزار قالب بندی، کلیک می‌کنیم یاClear Direct Formatting شمایل  روییا •

•Ctrl+M.را از صفحه کلید می‌فشاریم 

45 | قالب بندی بندها


